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Q01 : How to solve the problem of text cut off in the utility?
A01 : This problem is only existed in Windows XP if the font size is changed to “large font” for

high display resolution. Please change the font size of the OS to “standard.”

Q02 : How to learn the Sharp-like IR commands of the devices successfully?

A02 : There is an space time of approximate 40 ms in the Sharp’s IR protocol. Please launch the
utility of the IR learning remote module and go to the “IR-xxx Basic Settings” window
(Menu->[Setting]->[IR-xxx Basic Settings]) to increase the “GapTime” to more than 40 ms. After

that, the IR module can learn the IR commands successfully.

H” i
il Ll

A Complete IR Command

+«— GapTime

Space time of Sharp’s protocol is about 40 ms.

[=X)

IR-210 Basic Settings

Basic Parameters of IR-210

coMPort [Rs-485 v| Parity [Nene w| | Getsetting |
Baud Rate |9600—v| DataBits |8 =| | setTemporarily |
NetD (1 =] stopsits 1 _=ll [ setpermanently |
GapTime|] 48 {ms) Set permanently OK!

Set GapTime > 40 ms to learn Sharp IR protocol.

Q03 : Why can’t the utility connect to the IR learning remote module though the serial

communication settings are correct?

A03 : Besides the serial communication settings of Baud rate, Parity, Data bits and Stop bits, it
is necessary to consider two other factors: Modbus Net ID and Serial Interface (RS-232/RS-485)
which the IR learning remote module applies. To determine the serial interface, restart the IR
module and check the TR LED status in the first 3 seconds.

LED IR-210/IR-712 Status LED Status
Use RS-232 Blinks 3 times after power-on
Use RS-485 Turned on for 3 seconds after power-on
TR Use RS-232 / RS-485 Blinks 3 times after power-on. For firmware version

1.20 and later, RS-232 & RS-485 port can be used
without being configured by the utility.
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If the RS-232 cable CA-0910 was connected to the IR learning remote module » please notice that
the Rx/Tx/GND pins of the CA-0910 should be connected to the Rx/Tx/GND of the IR module’s

RS-232 port accordingly as shown in the following figure.

[k
Md dO
|_I:EI_

ZE‘Z" —l r?l.‘\l’lx_l-l

VIVD +YIYO OXL 0% ONE sA+ "9
E E E HH / y

— TXD:Pin 2 =

White

,— CaP-5X —|

Wire connection of the CA-0910 to the IR-210

When the USB-to-RS-232/485 converter was used with PC, please also confirm if the IR utility
opens the right COM port.
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Q04 : How to reset IR learning module to the default serial communication settings?

A04 : Please follow the steps below to reset serial communication settings:

1. Change the wire connection to the RS-232 port of IR learning remote module.

2. Open the PC COM port connected to the IR module in the utility with arbitrary communication
settings.

3. Click menu [Setting]->[Reset Basic Settings on IR-xxx] to open the reset window.
[ [R] Reset R-210 F5)

Please connect to the RS-232 port of IR-210.

Click Reset button within the first 3 seconds
right after the IR-210's power is on.

4. Click the “Reset” button within 3 seconds after restarting (i.e. power cycling) the IR module. If
the reset is successful, a “Reset OK” window will pop up to show that the IR module is now
changed to default serial communication settings temporarily, which means the settings will be
restored to previous ones after cycling the power. To avoid it after power cycle, please go to
the “IR-xxx Basic Settings” window (Menu->[Setting]->[IR-xxx Basic Settings]) to set the settings

by clicking the “Set Permanently” button.
[Reset oK (5] |

. | Reset to default settings temporarily!
' Please open Serial COM Settings dialog
to change settings permanently!

Table of IR-210 Default Communication Settings

ltem Default
COM port RS-232
Baud rate 115200 bps
Parity None

Data bits 8

Stop bits 1

Modbus ID 1
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AO05 : It depends on the resistance and length of the cable. There is a DIY example of using IR
emitter cables with 100 meters long. Four IR emitter cables can be made from an Ethernet Cat5
cable with 4 twisted pair cables. They are applied to the application of controlling 4 air
conditioners in a luxurious mansion. The application diagram is as follows.

Ethernet Cat5 cable

%]— =
L 100 meters ,E
N |

. A/C Remote Control

4 pairs of twisted wires

for 4 IR emitter cables.

3rd floor
- 3 |
= 9) ' 2 floor
TPD-280 = TN e
IR-210
")) | 15t floor

The length of the IR emitter cables (CA-IR-SH225x & CA-IR-SH225x-5) provided by ICP DAS are all
2.5 meters long. It is suggested to make the cables yourself if there is demand for a longer length.
The audio cable can be applied to extend the distance. For a longer distance like 100 meters, an

Ethernet cable is a suitable choice.

It is also noticed to buy the IR emitter diode (IRED) with IR wavelength 940 nm which is
commonly used in the consumer electronics. Please refer to the manual (Sec. 2.4.3) for the wire
connection among the IRED, the cable and the 3.5 mm audio jack plug, or as depicted in the

following figures.

TIP

RING
\‘

SLEEVE

SLEEVE
-

TRS Connector IR LED TS Connector IRLED
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Q06 :How to build IR remote application with the ICP DAS’s ISaGRAF PAC?
A06 :

Regarding the IR remote control with the ISaGRAF PAC, please refer to the link.
Please also refer to the ISaGRAP FAQ-152 for more details.

Q07 :Why can’t WISE-5800 controller connect to IR-712A?

A07 :

Please set the parameter “Modbus commands response delay time” of the IR-712A to 3 ms
(default = 1 ms) by IR-712A utility.

Steps:

IR-712A Utility’s menu [Setting] => [IR-712A Basic Settings] => [MB Cmd Resp Delay Time = 3 ms]
=> [Set Permanently]

Q08 :How to configure the communication to the IR-210/IR-712A in the WISE-5800?
A08 :

Take the IR-712A as an example.

> Communication Wire Conneciton
The WISE-5800 connects to the IR-712A by the RS-485 bus.

»  Web configuration of the WISE-5800
(1) Press “1.Basic Setting” Button and “Modbus RTU Module Setting” button to show the page.
Set the Baud, Mode, Address and Name for communication to the IR-712A. Then, press “Add”.

77 Web lnside, Smart Engine 1.Basic Setting 2.Advanced Setting 3.Rules Setting

N L Web Anywhere, Automation Anywhere! Channel Status Upload from Module Download to Module

’ Modbus RTU Module Setting Page

Name Setting
3 Baudrate(COM2) | (115200 v pps
iRt =g Silent Interval 4 milliseconds

Communication Setting

©4 Modbus RTU Modules + 16 1-7000 Modules\

Password Setting © 10 Modbus RTU Modules

Address 1 v
XW-Board Setting l ]
IR-712A_1 X
7
1-7000 Module Setting . . 1300 \mlTﬁseconds
Polling Timeout (Range. 1 ~ 10000)
Modbus RTU Module Setting Ut Re . 5 seconds

(Range: 3 ~ 65535)

5 Add | t@ Index|[1 v

(2) Add an IR-712A devices (IR-712A_1) as follows. Press “Setting” button for the IR-712A to set
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up the Modbus register address.

Modbus RTU Module List of COM2

® 1 1 IR-712A_1 300
SN d = 2 IR-712A_2 300
Time Setting - \ g - ; -
- 4 - - -
Communication Setting _ 5 _ -
Password Setting - g - -
- 7 - -
XW-Board Setting - 8 - o
_ |10 : :
1-7000 Module Setting
- 10 - - -
Modbus RTU Module Setting | Setting ‘I Remove H Move Up H Move Down ‘

(3) In the Attribute Setting page, set the Data Model = “Holding Register”, Start Address = ”1103”,
and Continuous Data Number = ”2”. Then, press “Add” button. (Note: Refer to the IR-712A
manual for the Modbus register address (chapter 5))

Modbus RTU Module Attribute Setting

T ——
16-bit Signed Integer

BT |
[ e |
Polling Timeout ‘ 300 millisecond(s) (Range: 1 ~ 10000)
Timeout Retry Interval ‘ seconds (Range: 3 ~ 65535)
Data Model ‘ ( Holding Register (4x) 1)
Start Address ‘
i 2
Continuous Data Number \

Data Type

|

Add

Nickname Setting

L SE Szt Coil Output Discrete Input Input Register Holding Register
ol 0Xx] 1x 3X| 4x
A (0x) (1x) (3%) (4x)

16-bit Signed Integer

Remove All Expand All || Collapse All

The WISE-5231 with built-in IR-210/IR-712A/IR-712-MTCP communication configuration is also
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recommended.

Q09 : How to integrate IR-712A with TouchPAD?
A09 :

The following uses TPD-433F project to explain how to develop the TouchPAD project with ladder
and C language to realize the control on the IR-712A (IR-210 also applies).

A. Ladder Diagram Programming
Steps:

1.Use mouse to right-click the “Connection” item in the Workspace tab. Select “New Connection”
to open the “New/Edit Connection” window and set the COM1 settings as the following figure.
B Framel - [TPD433F_IR712ADemo_hwd]
[E, File Edit View HMI Layout Arrange Run Window Help
Waorkspace lTDoIbox]
H-1 File

=l Broogram

125

Mew Connection
-Ad Tag 1

H-%# Device
B4 Virtual

[ New/Edit Connection_.

o | B .
Connection Name |COM_1
Connection Interfac |COM1 j
MNote: The interface i et Fewel=AD and 1/0

devices, not for downloading firmwargl

Serial Connection Settings
Baud Rate
Data Bit
Parity

Stop Bit

oK | Cancel |

2. Mouse right-clicking the Tag->Device in the Workspace and select “New Device”.
Fa Framel - [TPD433F_IR712ADemo.hwd]
g, File Edit Wiew HMI Layout Amange Run Window Help

Workspace lTooIbox]

B+ File

= Program

[z TPD433F_IRT12ADemo ldx
Connection

Con 1

b Mew Device

B4 Vi
\

8 ICP DAS Co., Ltd.



Universal IR Learning Remote Module (IR-210/IR-712A/IR-712-MTCP/IR-712P-MTCP) FAQ v2.2

In the Device Information section of the Device window, set the parameters as follows:

TouchPAD is: Modbus RTU Master
Device Series: IR _series
Connection: COM_1
Model Name: IR-712A
Net ID: Net ID of the IR-712A
[ pevices
—Device information Sianliddiessilbeian
flouchPADis:  [Modbus RTU Master  »|  \ ]
Device Series: IR_series (& ENABLE_AO Virtual 0
Connection- CoM_1 = R_ACTION Virtual 0 b
W_ACTION Virtual 0
Model Name: IR-712A Select | ERROR Virtual 0
Device Name:  [Dev_IR_712A_1 Assign ENABLE DEVICE  Virtual 0
Net ID- 5 -
'I'lQeout: 200 j | v
| OK I Cancel Clear All Tags
A

3. Back to the Workspace and go to the Tags->Device->Dev_IR_712A_1 item. Right-clicks the tag
“Devf IR_712A_1 R_Action” and set the default value to 0.

Fg Framel - [TPD433F_IR712ADemo_hwd]

@Eile Edit View HMI Layout Arrange Run Winc
Workspace | Toolbox |
E- File

&£ Program

-|'5 TPD433F_IRT12ADema ldx
Connection

. 548 Dev_IR_T12A_1
73 Dev IR_T12A_1_AQD
{3 Dev_IR_T12A_1_AO1

Cloa, 10D 7424 4 CRLADE A ™M

..... Dev_IR_712A_1_R_ACTION

[ it Tag / BEIEXE

Name IDev_IR_T12A_1 yﬁﬂom

et 8

Binding |

Comment I

OK Cancel
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4. Right-click the Tags->Virtual item and select the “New Virtual Tag” to add a v1 Tag.
Fa Framel - [TPD433F_IR712ADemo hwd]

mfile Edit View HMI Layout Arange Run W
Workspace | Toolbox I

#- File

=& Program

[& TPD433F_IRT12ADemo.ldx
Connection

Mew Virtual Tag

ew Folder

(2 Edit Tag / (=

Name I\f“

Default I 0

Binding |

Comment ||

e

5. Add a BitButton control in the display section of the TPD-433F. Set the TagName property on

the button to v1.
10.hwd]

wt  Arrange Run  Window Help

sl (| oo IPEReGE TIR-CLA S LENMV St

| BitButton

w | || Taghame J
Ferp IIﬂIIUIII;LIRLrIII_._
............................................... TOP 9.2
S e True
............................................... ot ot

b " Frame1 ,l{FrameE,r

10
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6. Open the “Program” item in the workspace and double-click the Idx file to open the
HMIWorks Ladder Designer window.

[ [E Framel - [TPD433F_IR712ADemo.hwd]
E,Eile Edit Wiew HMI Layout Arrange Run Window Help
Workspace ITUDIbe] Ir
o Fle T T 7
|f—|"'L=—'=| Erugram L TPD-433F + IR-7T12A DEMO o E
-] TP D433 IR712ADemo.|dx | || SRR AR
=i ConmeTTon ‘\IZZIIZZZIZZZIIZZIIZZZIZZZIZZZIIZZIIZZZIZZZIIZZI i
- Bocom1 NN L R C
E---@Tags 'ZZZZZZZ..“""""""""""""""ﬁﬁﬁﬁﬁﬁﬁﬁﬁ F
& Device \ S ¢
e Viual 0 b\ m  Transmit IR Cmd#? from IR autout#! e oo L
Press F2 button to add a normally opgn contact.

F2<E

I, |

oy 1

Double-click the normally open contact and set v1 tag to the contact.

®a HMIWorks Ladder Designer

Eile  Edit
F2 3E | F3 !E| F4|ag‘ F5-()l| F& I} ‘ F? ﬂ:| FSI,,,I| FS%}‘_F
1 O |
?, Select Tag
BFDWSBTEQS] ter Constant BindTagsl
Scope |(Virtua|} j

Cancel
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7. Press F7 button to add an empty function block.
Fg HMIWorks Ladder Designer
File Edit

F2 3E |F3 !E‘ ngg‘ F5-()-|F5=D- | r M |,r|| Fa—>>|F1n|

L, e ) S

Double-click the function block to open theAvindow and select the “Assign” function in the
“IR-210" class.

Fg HMIMWorks Ladder Designer
File Edit

F2 3E |F3 !E| F4|aé‘ F5 ()| F& 3} |F?‘ ﬂ:|FB|,,|| FS—»‘HD|

@

. yd ( )
J

@ Function Block r

default
math
convert
counter
timer
system

user_define
yoD.4a0

Function Name Display Mame

Set the out and in of the “Assign” function block to “Dev_IR-712A_1 AOO0” and “2”, where “2”

means IR command number 2.
Pz HMIWorks Ladder Designer
File Edit

F2 3E ‘FS !E| F4|a.:J| F5{}l|F5ﬂ |F? ﬂ:|F8I=rI| F9%>|F1n‘

v =
D | e
| | ey
W Select Tag
Browse Tagsg l Enter Constantwind Tags ]
Scope  |Dev_IR_T12A 1 | Clea
llame Comment

‘u Dev_IR_712A_1_AOO

| | I . S e
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Pz HMIWorks Ladder Designer

|F? ﬂ:|F8L_u__I| F9—>>|F10|

En

Diew_IR_7124_1_A00

O

[ Select Tag

Browse Tags

Enter Constant l

Cancel |

8. Please follow step 7 to add another “Assign” Function block. This time, set the out and in of
the “Assign” function block to “Dev_IR-712A_1_AO1” and “1”, where “1” means IR Output 1.

Eile Edit

@ ok G s

en

Dev_IR_7124_1_A00

eno

F2 3E |F3 !E| F4|a,:J| F5-(}||FB{I. |F? ﬂ:| F8|,,,|| F9—>>| F1D|

en

=
(%)

eno|

9. Add an empty function block at the right side of the “Assign” FB in step 8. Double-click the
empty function block to open the window and select the “Assign ” function in the “default”

class.

k Ladder Designer

IE | Fé4 g F5-()l|F8ﬂ |F?

Dev_IR_7124_1_a01

En

aut

in|

G| e | FH>|?L
1 E}

convert
counter
timer
system
user_define
VPD-130
IR-210

[@ Function Block

Function Name Display MNan
|_|AMND and

OR or
_)(OR Xor

Equal

OnChange

13
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Set the out and in of the Assign function block to v1 and O correspondingly. Save file and close
the ladder designer.

Fg HMIWorks Ladder Designer

File Edit

F2dE |F3 !El F4|£| F5-(}I|F5ﬂ |F?‘ ﬂ:| FEH,,,|| Fs%>| le

Dev_IR_7124_1_a0T|out inf1

]

w1]out

10. Finally, press F9 key to compile and download project to the TouchPAD.

Framel - [TPD433F IR e
[m File Edit Wiew HMI Layout Arange__Bug \Window Helg
orkspace | Taah o -
=0 A Tung & Render =57
éEIPlrcergram s Render Only Ctrl+F5 |~~~
el C -7112A DEMO - -
[ TPDATIF IRTI2ADemold ||| DowmoadOnly  CuleR RERARCEEEE
EiCnnnection S Set up Device (TouchPAD) T
- ¥ com_1 - | Download File (UserBin) |- .
=4 Tags SR I
@ Device o Console (cmd.exe) F10 R
=@ Vitual |} ®  Transmit IR Cmd#2 from IR output#1 [= - - - -~

B. C Language Programming
Steps:

1. Please refer to step 1 to 3 of “A. Ladder Diagram Programming”.

2. Add a BitButton control in the display section of TPD-433F in the HMIWorks IDE.
Double-clickthe OnClick property to add a OnClick event handler.

[72) Frame2 - [TPD433F_IR712ADemo.hwd] | /
[@Eile Edit View HMI Layout Arrange Run Window Help EEE

|
Waorkspace T00||J0X| =

Inspectar | Libraries |

Drawing ||l - —

Widget

........... TPD-433F + IR-T12A C DEMO ... ... |Enabled True

........... Font (Font)
L g T TN GoToFrame
R Height 86
....... . D 7
T | ] Left 95
R WET.oT-S—

....... OnClick BitButton?OnClick M
OnRelease
Tag 0
Text Transmit IR Cm...
Top 84
Visible True
Y RadioButton Width 306
N
« I | » i

Ty

E' Auetrt | e |
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3. Copy the following C code to the OnClick event handler. It sends Modbus command to

IR-712Aand write data to address 1103(IR command number) and 1104(IR output channel) of
holding registers.

void BitButton70nClick(tWidget *pWidget)

{
HANDLE h;
int NetID = 5; // Net ID of IR-210/IR-712A
int addr = 1103; // address of the holding register "IR cmd number"
int ch_count = 2; // Count of address 1103,1104 amounts to 2.
WORD AO_value[2]; // array for the two holding registers (AO)
AO_value[0@] = 2; // IR command number => 2
AO_value[1l] = ox01; // IR output channel => IR output 1
h = uart_Open("COM1,9600,N,8,1"); // Open COM1 (RS-485) of TPD-433F
// Command IR-210/IR-712A to transmit IR signal.
mrm_WriteAO (h, NetID, addr, ch_count, AO _value);
uart_Close(h); // Close COM1 of TPD-433F
}
[E E - \_Frame2h - dmae SR X
File Edit Search
oK ‘ Cancel ‘ Goto Line | |1
1 void BitButton7OnClick({tWidget =pWidget) P
24
3 HANDLE h;
4 int HetID = &5; /7 Net ID of IR-218/IR-712A
5 int addr = 1183; // address of the holding register "IR cmd number™
I & int ch_count = 2; £/ Count of address 1183,1184 amounts to 2.
7 WORD AO_value[2]; // array for the two holding registers (AD) ‘|
I 8 AO0_value[B] = 2; // IR command number => 2
s AD_value[1] = @x@1; // IR output channel => IR output 1
I 10 h = wart_0Open{"COM1,9688,H,8,1");
11 // Command IR-218/IR-712A to transmit IR signal.
| 12 mrm_l.u'riteﬂl] {(h, HetID, addr, ch_count, AO_value};
13 uwart_Close(h);
14 )
15
il 16
« [ r

4. Press F9 key to compile and download the project to the TouchPAD.

15 ICP DAS Co., Ltd.
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Al10:
Generally speaking, it can be 7~8 meters at least if using CA-IR-SH2251 with the IR learning
remote modules (IR-210/712A). However, it depends on the application condition and the
surroundings. There are some possible factors to inference the range of remote control distance:
(1) The length of the IR emitter cable. The longer the IR cable is, the shorter the distance of
remote control.
(2) The sensitivity of the IR receiver of the controlled appliances.
The receive angle to the IR receiver also affects the distance. The larger the angle is, the
shorter the distance of remote control.
(3) The interference from the sun light, (compact) fluorescent lamps, LCD/PDP TV, ..., etc.

There is a case which is 10 meters long for the IR-712A + CA-IR-SH2251.

Q11 : How to avoid the IR emitter cables interference by the neig ing VGA cable?
All:

The high frequency noises from the VGA cables or other devices may interfere the signals in the
IR emitter cables. It is proposed to add ferrite (magnet) cores near the head and jack plug of the
IR emitter cable, as shown in the following pictures, to suppress the interference.

16 ICP DAS Co., Ltd.
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Q12 : How to apply the IR learning commands to multiple IR learning modules ?

Al12:

IR learning commands can be saved to an IR leaning data file with file extension “ird” for backup
by the IR utility. Users can download the IR leaning data file to multiple IR leaning modules by
the IR utility without the IR learning process again. The configuration works on RS-232 and
RS-485 interface.

m After the IR learning process, save the IR learning commands to IR learning data files for

backup.
IR Utility => Menu [File] => [Save IR Commands to File]

m R utility loads the IR learning data file.
IR Utility => Menu [File] => [Load IR Commands from File]

m Download IR learning commands to an IR learning module.
IR Utility => Menu [Download] => [Download IR Commands to IR-xxx]

m Batch-download an IR data file to multiple IR learning modules.
IR Utility => Menu [Download] => [Batch Download IR Commands to IR-xxx]

This is for multiple IR modules connected (multi-drop) to an RS-485 bus. Select the range of the
Modbus Net ID and press the “Start” button in the following window to launch the process.

Batch Downloading an IR Learning Data file

Net ID from | 1 v to 5 w0

D Net 1D = 1, 100% Success!
B Nt D = 2, 100% Success!
- Net ID = 3, 17% Downloading
Net ID = 4, 0% Waiting
Net ID = 5, 0% Waiting

..........................

Stop Close
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Q13 : How to copy IR commands from other IR learning data files ?

Al3:
The Copy-IR-Commands Function can avoid IR learning process again by copying the IR
commands from the existing IR learning data files to the destination one.

X Note: IR learning commands from IR-210 and IR-712A can be used interchangeably. The IR
commands from IR-712-MTCP cannot be used by other modules.

Steps:

a. IR utility loads the destination IR learning data file (e.g. “BenQTV_IR-210_20150701.ird”). Or,
press the “Set Device & IR Command Quantity” button to add new device and configure IR
commands quantity..

IR-210 Utility - COM3 - EAIR_Demo’R-2100BenQTV_IR-210_20150701.ird
File Download Sefting Tool Help

Cpen / Close COM port

COM Port |COM3 |E| Parity  |None v| Stop Bits | 1 |

Open
Baud Rate | 115200 | Data Bits | & ~| NetiD 1
Test and Save Learned IR Commands
Device Mame : Command Name : IR Lear
1_BenQ TV v| 1_PowerToggle - .
1_PowerToggle
Save this Cmd | |2_Ch+ Cutput
3_Ch-
4 Vol+
& Vol- IR Carr
G_num0
Test IR Commands in IR-210 7_num 1

IR Command No.: |1 » | Qutput Ch 9_LCommand
:| . 10_LCommand
Modbus/RTU message (with CRC16) sen 11_LCommand
12_LCommand m
13_L Command _| Copy | E
14_LCommand
15_LCommand
16_LCommand
17_LCommand

b. Open the copy IR commands window.
Select the item in the Menu [File] => [Copy IR Cmds from File].

[IR] IR-210 Utility - COM3 - EAIR_Demo\IR-210\BenQTV_IR-210_20150"
[File| Download Seiting Tool Help

j Load IR Commands from File !

|
Unload IR Commands one  + | Stop Elits[']
| E—

ld Save IR Commands to File
~| NetiD 1

l:'ﬂ Copy IR Cmds from File

g3 Exit Command Name :

c. Steps of copying IR commands. Please refer the following figure, too.
1. Browse & open the source IR learning data file. (e.g. “AMDS_Code006_20150511en.ird”)
2. Select the items of the source and current (destination) “Device Name” combobox.
3. Select the IR commands for copy in the source IR commands table (multi-selectable).
4. Select the start row in the current (destination) table (uni-selectable)
5. Press the “Copy” button “>>". The items from the start row in the current table will be
replaced with the copied IR commands.
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6. Press “Apply & Copy” button to finish copy.

Copy IR Commands from File

Full Path of the Source IR learnig data file

Deyice Mame (Sourcel

E\R_Dema\IR-Z100AMDS_Cade008_20150511en.ird

Dlevice Name (Cumrant]

1 AMADUS A/C

[l_BenQ v

IR Command Mame .

IR Command Name |:|

Mo# IR Command Mame
PwrON-25C FanAuto 1 PowerToggle = |
PwrOFF- | | 2 [chs
|25CFanAuto [ | S |3 Jon
C FanAuto 4 Vol+
ommand . 5 Vaol- 5
6 LCommand 6 num 0 1
7 LCommand 7 num 1 A
3 LCommand i - -
9 LCommand 9 LCommand
10  |LCommand ol 2 —
11 |LCemmand
12  |LCommand
13  |LCommand r -
[ —
[ Restare ]I Apply & Close l[ Cancel
———
The following figure shows the copy result:
Copy IR Commands from File EI’E‘@

Full Path of the Source IR leamig data file

E\R_Demo'IR-21MAMDS_Code006_20150511en.ird

Device Mame (Source)

1 AMADUS_A/C

7

IR Command Name .

Device Mame (Current)

1 BenQ TV

IR Command Name .

Mo# IR Command Name No# IR Command Name
1 ) 1 PowerToggle
2 2
3 3
4 4
5 LCommand ws 5
6 LCommand 6
7 LCommand 7
3 LCommand 3
9 LCommand anAuto
10 |LCommand FanAuto
24C FanAuto
12 |LCommand
13  |LCommand

Restore l [Apply & Close] [

Cancel
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IR-210 Utility - COM3 - EAIR_Demao)\R-2100BenQTV_IR-210_20150701.ird
File Download Sefting Tool Help
Cpen / Close COM port =
COM Port |COM3 v||E| Parity [None | StopBits|1 -
2 e Open
Baud Rate [ 115200 v| Data Bis|8 v| NetiD 1 -
Test and Save Leamed IR Commands
Device Name - Command Name : IR Learning Mod
1_BenQ TV ~| [5_PwrON-25C FanAuto Bl |
1_PowerToggle
Save this Cmd | g_g::* Output Channel :
4 Vol+ - |
£ Vol IR Carrier Freq. :
G_num D
Test IR Commands in IR-210 7_num 1
IR Command No.: |1 v| Outpu
10_PwrOFF-25C FanAuto
Modbus/RTU message (with CRC16) §en| 11_24C FanAuto
T rCommang
13_LCommand p | Gopy | | Clear |
14_LCommand
15_LCommand
16_LCommand
17_LCommand

d. Save IR commands to the file.
Menu [File] => [Save IR Commands to File]

Q14 :Is there any IR API library?

Al4:

The IR API library supports the desktop application development on Microsoft Windows
operation system. There are VC++ and C# library for programming. The IR API library supports
IR-210/1R-72A/IR-712-MTCP.

Download link: ftp://ftp.icpdas.com.tw/pub/cd/usbcd/napdos/ir/software/library/windows/

Q15 : Is there any Modbus registers for IR learning and load /download IR data?
Al15:

Please refer to the link: http://www.icpdas.com/en/download/file.php?num=5230

Q16 : What's the difference between the IR cable CA-IR-SH2251 and CA-IR-SH2251-5?
Al6:

1. The diameter of the IRED (InfraRed-Emitting Diode) of the CA-IR-SH2251 is 3 mm. The
diameter of the IRED of the CA-IR-SH2251-5 is 5 mm.

2. The emitting case volume of the CA-IR-SH2251-5 is 3 times larger than that of CA-IR-SH2251.
3. The wireless remote control distance of the CA-IR-SH2251-5 is approximately 10% longer than
the CA-IR-SH2251.
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Q17 : Are there ASCII string commands to control emtting IR signal?
Al7:
Besides the Modbus protocol commands, there are DCON protocol commands (ASCIl string

commands) to control emitting IR signals. This function is supported after the firmware version
as follows:

IR-210: firmware version v2.00 and the later.
IR-712A: firmware version v2.00 and the later.
IR-712-MTCP: firmware version v2.6.0 and the later.

Q18: IR Utility has identified the IR-712(P)-MTCP device, but it’s unable to establish a

connection. How to resolve the issue?

A18:

Please check if your computer has multiple IP configurations. If you have multiple IP
configurations set up, make sure that the IP address within the same network segment as the
IR-712(P)-MTCP device is configured as the primary one. The figure below illustrates multiple IP
configurations where the module can be detected the IR-712(P)-MTCP but not connected.

EETCPPRE X
IPEE DNS  WINS
1P I R)
[IR] & Utility -v1.9.2.0 X e E——
Eile Tool About 10.1.1.188 255.255.00
// T92.168.255.188 255.255.00
Module: | R712(P)4TeP | | search Modules | | Open Iterface |
FEQ.. RED.- BHW
Module Name ~ FW Ver IP Address Caution % Description
IR712P-MTCP  2.9.7  192.168.255.1 Universal IR | zaming Remote Mo HEEEQ
151 27l
! ‘Connection Timeout!
HED gET HEM
BEFHEW

The figure below shows the correct IP configuration where the IP address within the same
network segment as the IR-712(P)-MTCP device is set as the first configuration.

EETCPAP BE x
FEEERERRETE 418 (TCH/IPW) - AF X
PRE DNS  WINS

1P {HE(R)
. SLIREEEERMN IPRE - T8 E4E - .
= P {3 FEREE
/v 192.168.255.188 255.255.0.0
/ 10.1.1.188 235.255.0.0
4. | [ sw0
e
@ EETFI DN ARBNLE P =am BEM
=i DNS EEER): [ ] sEEEQW
O#=mEsszE0 EREM)...
2

X
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Q19 : How to use the Ladder language of TouchPAD with IR-712(P)-MTCP?
Al19:

The following uses TPD-703 project to explain how to develop the TouchPAD project with ladder

to realize the control on the IR-712-MTCP/IR-712P-MTCP.
Steps:

1.Use mouse to right-click the “Connection” item in the Workspace tab. Select “New Connection”
to open the “New/Edit Connection” window and set the IP settings as the following figure.

Mewy/Edit Connection *
@ HMIWorks STD v2.30.11 (Feb.03, 2023) - [Test_forlR]
@ File Edit Layout Arange View HMI Project Run Window Help Connection Name |TCP|P_0 Assign Name
Workspace lToD\box] Connection Interface TCPIP <
7
-0 File Mote: The interface is for colgmunication between TouchPAD and IO
7 Test forlR hwd devices, not for downloading tnware
SR =2 Emgfamf Rig TCPYIP Connection Setting
L2 Test_forlR.ldx
=10 - Remate IP 192168 255 1 2.g.010.1.0.100)
MNew Caonnection
B2 Tal Port 502 e.g.- 502)
& Device
- \firtual I~ TouchPAD as a Server

OK Cancel

2. Mouse right-clicking the Tag->Device in the Workspace and select “New Device”. In the Device
Information section of the Device window, set the parameters as follows:

TouchPAD is: Modbus TCP Master

Device Series: IR_MTCP

Connection: TCP_O

Model Name: IR-712-MTCP

Device Name: (Device name of IR-712(P)-MTCP)
Net ID: (Net ID of IR-712(P)-MTCP)

@ HMWorks STD v2.30.11 (Feb.03, 2023) - [Test_forlR]
@ File Edit Layout Amange View HMI Project Run Window Help

Workspace | Toolbox |
)
) Test_forlR wd
== Program
B Test_forlR ldx
- Connection
.. % TCPIP_0
B Tags
Eg'f New Device |
@ Vil
Select [R_MTCP] Series .. X
Model Description
2 Devices / - 0o x IR210
Device information Tag Name [0 Type [Defautt [Constant__[Forcewvrite [Comment |~ IR-712A
ouchPAD is:  [Modbus TCP Master IR outt Virtual 0 0 1
[ |IR_outz Virtual 0 0 1
Device Series:  [IR_MTCP - | |ERROR Virtual 0 0
Connection: TCPIP_0 - | |ENABLE_DEVICE__\ ! ! 0
E]
Model Name:  [[R-T12MTCP Select ||—
Device Name: | IRT12MTCP Assign
Het ID 1 / (1~247)
Timeout. [200 ms
Scan Time - 200 ms v
< >
Cancel Clear All Tags Gancel
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3. Right-click the Tags->Virtual item and select the “New Virtual Tag” to add two Send Tags. The
one is “Send_ch1”. The other is “Send_ch2”.

E HMIWorks STD v2.30.11 (Feb.03, 2023) - [Test_forlR]

@ File Edit Layout Arange View HMI Project Run Window Help

Workspace | Toolbox |

B3 File
H ) Test_forlR.hwd
Program
[ Test_forlR.ldx
i Connection
o -B TCPIP_D
B4 Tags
=-& Device
B8 IRT12MTCP
-5 IRT12MTCP_IR_Out”
-#3) IRT1ZMTCP_IR_OutZ
if2 IRT1ZMTCP_ERROR
72 IRT12MTCP_ENABL
x4V rival

[ New Virtual Tag

New Folder

—

4. Add two BitButton controls in the display section of the TPD-703.

(B HMMWorks STD w2.30.11 (Feb D3, 2023) - [Test_forlR]

B Fle Edit Layout Amange View HMI Project Run Window Help

Workspace Toolbox |

2| Arrow
BN TextPushButton
= Slider

& BitButton

I RadioButton

Edit Tag X
MName ISend_ch1
w| Default I 0 ey e R )
Source Type int32 -I
Comment
10 Type Unknown I Constant [~ Force Write
Binding I
gance |
Edit Tag *
N\
MName ISendichﬁ
Default I 0 Tl 2 O )
Source Type Imt32 -I
Comment |
10 Type Unknown I Constant [~ Force Write
Binding I
conce|
- a x
“
Irapecior | Libwares |
[EBBuons |
Aux L]
Enabled True
Font iFont)
GoToFrame
Height i)
o 4
Left 62
Name BitButton
Taghlame
Toxt BitButton
Top. 63
(~ : D e
™ . BitButton .

System (Cirt+3) ~Fromel
Results x|
output  Errors |
Line Type. File Message

D703 Ethemet: [IP-192.169.255.100L, MAC-0000E0:6F.00:75] Selected: 1
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5. Set the BitButton1 TagName property on the b

spetr | s

T —C
A 0

o x
|

utton to “Send_ch1”.

Select Tag
1 Browse Tags | Enter Constant | Handle |

= Transmit IR Cmd#31 from IR output #1

| Transmit IR Cmd#31 from IR output #2

Fesults
Output Ervces

|| Scope [(Global)

=l Fiter |

Clear Selection ‘

Name

|comment

‘ ~

IR712MTCP_IR_Out1
IR742MTCP_IR_Out2
IR712MTCP_ERROR
IR712MTCP_ENABLE _DEVICE

Send_ch2

.
ol

TPT0 Wil

tton2 TagName property on the button to “Send_ch2”.

AR

o | [selectTag

Browse Tags | Enter Constant | Handle |

Transmit IR Cmd#31 from IR output #1

f

| + Transmit IR Cmd#31 from IR output #2

Famat]

Results
Guiput £ |

Scope  [(Global)

=l Firer

Clear Selection |

Name

|comment

‘ ~

IR712MTCP_IR_Qut1
IR712MTCP_IR_Out2
IR712MTCP_ERROR
IR712MTCP_ENABLE_DEVICE
Send_ch1

<
Cancel

v
<

TP6-103 Virtual

6. Open the “Program” item in the workspace and double-click the Idx file to open the

HMIWorks Ladder Designer window.
[ HMI\VWorks STD v2.30.11 (Feb.03, 2023) - [Test_forlR]

EE”E Edit Layout Arrange Miew HMI Project Run Window Help

Workspace | Toolbox |

-0 File
. il Test fordR hwd
= Program

{ = e |

L TCPIP_O
E- Tags

=& Device

. BE-d8 IRT12MTCP
{3 IRT12MTCP IR _Out®
2 IRTA2ZMTCP_IR_Out:
2 IRT12MTCP_ERROR
5 L. {3 IRT12MTCP_ENABL
B4 Virtual

‘g8l ir_addr_1103
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7. Press F2 button to add a normally open contact. Double-click the normally open contact and

set “Send_ch1” tag to the contact.
%)

File Edit Search

j Filter ‘ Clear Selection

|Cummem 2]

Name\
M IRF12MTCP_IR_Out1

R7T12TCP_IR_Out2

IR7T12MTCP_ERROR

IR7T12M¥CP_ENABLE DEVICE

Send_ch ]
|_|Send_ch2

Cancel

Press F2 button to add a normally open contact. Double-click the normally open contact and set

“Send_ch2” tag to the contact.
=

File Edit Search

]E|F4Iaé B | g | fE| | r» | mo | spacem|
Send_ch1
' ——

z 4

Select Tag -

:BTDWEE Tags I nter Cnnalam} Handle I

Scope\  [(Global) oRe | Clear Selection
Name\

IR7121\TCP_IR_Out1
IRT12M{CP_IR_Out2
IR712MTCP_ERROR
IR712MT§P_ENABLE_DEVICE
Send ch

Send_ch? ]

|Cummem 2]

) I K2

Cancel
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8. Press F7 button to add an empty function block. Double-click the function block to open the

window and select the “Assign” function in the “default” class.

File Edit Search

F23E ‘ F3 '!E‘ Fuag‘ FE'() Fa = | FoD | spacen

b _,H\i—o—A

send_ch2 ‘ Fu Mu ok x
: b 0 Function Name Display Name [Caption Al |
AND and and (2 ftems)
|| AnD4 and and (4 items)
|| anps and and (8 ftems)
| |or or or (2 items)
e | |ord or or (4 items)
user_dsfine OR8 or or (8 items)
DEW-521 | [xor xor exclusive or
I aace | |Equal Equal Equal function
Equal_And2 Equal (And) Twe equal conditions (And)
|| Equal_Ands Equal (And) Four equal conditions (And)
|| Equal_Ands Equal (And) Eight equal conditions (And)
| |Equal_or2 Equal (Or) Two equal conditions (Or)
| |Equal_on Equal (Or) Four equal conditions (Or)
[ |Equal_oms Equal (1) Eight equal conditions (Or)
||nE < not equal
| |NE_And2 <> (And) Two not-equal conditions (And)
|| NE_Ang4 < (And) Four not-equal conditions (And)
| |NE_Ands < (And) Eight not-equal conditions (And)
| |nE_o2 < (01) Two not-equal conditions (Or)
| |NE_ou < (01 Four not-squal conditions (Or)
| |nE_ors < (0r) Eight not-equal conditions (Or)
|| Greater > greater
HES sz greater or equal
| |Less < less
e <= less or oqual
assign 2 fems
Assignd = assign 4 items
e {
< >
Cancsl

Press F7 button to add another empty function block. Double-click the function block to open

the window and select the “Assign” function in the “default” class.
B HbWorks Ladder Designe _—

File Edit Search

F2<E ‘ F3 iE‘ Fdlaé‘ Fﬁi‘mm |._n_|‘ Fa~»| Fﬂl‘Spacsm‘

Send_ch1 =

N || S —|

out in|
Send_ch2 )

b —— -\——O——|
Fum:tmw.:k X

convert Function Name Display Name [caption

| |oRs or or (4 ftems)
| |ors or or (8 ftems)
flash XOR xor exclusive or
Zfé.lm | |Equal Equal Equal function
s | | Equal_And2 Equal (And) Two equal conditions (And)
user_define Equal_And4 Equal (And) Four equal conditions (And)
DGW-521 || Equal_anda Equal (And) Eight equal conditions (And)
\\Q%Qi;'rcp | |Equal_o2 Equal (O1) Two equal conditions (Or)
| |Equal_or Equal (Or) Four equal conditions (Or)
Equal_Or8 Equal (01) Eight equal conditions (Or)
| |nE < not equal
| |NE_And2 <> (And) Two not-equal conditions (And)
|| NE_And4 < (And) Four not-equal conditions (And)
NE_Ands <> (And) Eight not-equal conditions (And)
| |nE_Or2 < (o) Two not-equal conditions (Or)
| |NE_Or4 <= (0r) Four not-equal conditions (Or)
| |NE_Or < (on) Eight not-equal conditions (Or)
Greater > greater
GE >= greater or equal

=sn
| Assigns E assign 4 items
| | Assigns = assign 8 items

OnChange OnChange OnChange function
| | InRange InRange Value in the range
| outrange OutRange Value out of the range

.

< >

Cancel
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9. Set the “in” and “out” of the “Assign” function block to “31” and “IR712MTCP_IR_Out1”.
Where “31” mean IR command number 31. where “IR712MTCP_IR_Outl” means IR output

channel 1.
®

File Edit Search
F2 € ‘ F3 'lEl F4|_,E|| rs-()u‘ & {3 ‘ F7 ﬁ‘ FSI,-,I‘ Fa%)‘ F‘\D‘Spaceml

Send_ch1 ;:_l
I I n e 4'

L T
[ ut in
Send_ch2 =

2 A n
I 1
out
Select Tag -
Emer Constant | Handle |
Scope\  [(Global) = Fiter Clear Selection

Namey
[ R712MTCP_IR_Outt
IR7A2MTCP_IR_Out2
IR7T12MTCP_ERROR
IRT12MTCP_ENABLE_DEVICE
Send_ch1

Send_ch2

<

Gancel

Enter Constant |Handle |

Browse Tags

OK Cancel

a1

Set the “in” and “out” of the “Assign” function block to “31” and “IR712MTCP_IR_Out2”. Where

143
B

File Edit Search

F24E ‘ F3 1E| FAIEEI‘ ra{n‘ F& {3 |F7 ﬂ‘ FEIcl‘ Fa%}‘ FWD‘Spaceml

Send_ch1
I | | n .
\ —

T f

A712MTCP_IR_Qutlfout inj31
Send_ch2 =

U e e

X

SelectTag-
Browse Tags | Enter Constant | Handle |
Scopt  [(Global) A Fiter Clear Selection
[Namb [comment A

IR7T1§MTCP IR _Out1
[d IR712MTCP_IR_Out2
IR712MTCP_ERROR
IR712MTCP_ENABLE_DEVICE

Gancel

1” mean IR command number 31. where “IR712MTCP_IR_Out2” means IR output channel 2.

Enter Constant |Hande |

Browse Tags
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10. Finally, press F9 key to compile and download project to the TouchPAD.
@ HIWorks STD w2 30,11 (Feb.03, 2023) - [Test_forlR]

I File Edit Layout Amrange View HMI Project Run Window Help

Workspace lTnnIbnx]

F-10) File

E|l._= Program

- [H Test_forlR Idx

=i Connection

- S TCPIP_O

E@; Tags
=& Device

=@ IRT12MTCP
E IR712ZMTCP_IR_Out?
E IR7T12MTCP_IR_Out2
E IR7T12MTCP_ERROR
- IR7T12MTCP_ENABLE C

=42 Virtual

Q20 : How to use the Clan
A20:

Fun (Render> Compile> Download) F9

Build (Render=> Compile)
Render
Compile

Download

Set up Device (TouchPAD)

Download File (User Bin)

Console (crmd.exe)

Auto-Switch USE Mode

F5
Ctrl+F3

Ctrl+F9

F10

uage of TouchPAD with IR-712(P)-MTCP?

The following uses TPD-703 project to explain how to develop the TouchPAD project with C
language to realize the control on the IR-712-MTCP/IR-712P-MTCP.

Steps:

1.Use mouse to right-click the “Connection” item in the Workspace tab. Select “New Connection”
to open the “New/Edit Connection” window and set the IP settings as the following figure.

@ HMMorks STD v2.30.11 (Feb.03, 2023) - [Test_forlR_CLang]
@ File Edit Layout Arange View HMI Project Run Window Help

MNew/Edit Connection

*

[TCPIP_0

Workspace lTooIboxl
=0 File
i -l Test_forlRohwd

Program
-[H Test_forlR.Idx

Assign Name

Connection Mame
Connection Interface |TCF‘IF‘

TCP/IP Connection Setting

™ TouchPAD as a Server

Remote IP 192.168.255.1
Port 502

oK Cancel

2.g.: 10.1.0.100)
e.g.: 502)
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2. Mouse right-clicking the Tag->Device in the Workspace and select “New Device”. In the Device
Information section of the Device window, set the parameters as follows:

TouchPAD is:

Modbus TCP Master

Device Series:

IR_MTCP

Connection:

TCP 0

Model Name:

IR-712-MTCP

Device Name:

(Device name of IR-712(P)-MTCP)

Net ID:

(Net ID of IR-712(P)-MTCP)

3 HMM/orks STD v2.30.11 (Feb.03, 2023) - [Test forlR Clang]
P File Edit Layout Arange View HMI Project Run Window Help

Workspace | Toolbox |

B File
{7 Test_forlR hwd
e+ Program
[ Test_forlR ldx
- Connection
#, TCPIP_0

< New Device "
@ Vit
° Select [IR_MTCP] Series X
Model Description
[ Devices / - o X IR-210
 Device information ¥ Tag Name [i0 Type [Default [Constant _[ForceWrite [Comment | » IR712A
[Modbus TCP master 3 M IR_Out1 Virtual 0 0 1 R
L IR_Out2 Virtual 0 0 1
Device Series:  |IR_MTCP. - [ |ErROR Vitual 0 0
Connection: TCPIP_0 - | |ENABLE_DEVICE ! ! 0
Modsl Name:  [R-712-MTCP Select ||-—
Device Name:  [R712MTCP. Assign
et 1D 1 ) (1~247)
Timeout. 200 ms
Scan Time 200 ms M
< >
Cancel Clear All Tags Cancel
4
4. Add two BitButton controls in the display section of the TPD-703.
B HtanWorks STD w2301 (Fek.03, 2023) - [Test_forlR_CLang] - 8 *
B Ble Edit Layowt Amange Wiew HM! Project Bun Window Help x
Workspace Toalbox | epeco | s | i
[GEButont -]
[ax @
EAFI"W Enabled True
BV TextPushButton e
—=[slider I ,HD“QM ;-w
| = mitaiitton Lea 0
. Hame. BitButton
HotSpot Taghlame
[F1 CheckBox = o
3 Laver : & ' ") -
[ RadioButton
B B BitButton

)

BitBution

System (Cut+3) et
Results x
Ougut Errors |
Une | Type File Message
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5. Double-click the OnClick property to add a OnClick event handler.

@ HMIVorks STD w2.30.11 (Feb 03, 2023) - [Test_forlR_CLang] - O 'Y
@ File Edit Layout Arrange View HMI Project Run Window Help _ax
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Double-click the OnClick property to add a OnClick event handler.
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6. Copy the following C code to the OnClick event handler. It sends Modbus command to
IR-712(P)-MTCP with IR output channel 1 and write data to address 1103(IR command number)

and 1104(IR output channel) of holding registers.

1. void BitButton4OnClick(tWidget *pWidget)
2. {

3. //Handle for TCP connection

4. tHandle h ;

5F

6. //Modbus/TCP server information

7. int Modbus_NetID = 1;

8. int Server_IP[4] = {192,168,255,1};
9. int Modbus_Port = 502;

10.

11. //Modbus Address
12. int Modbus_addr = 1103;

13. int ch_count = 2; //address 1103 & 1104
14. WORD AO_value[2];

15. DWORD timeout = 200; //200ms

16.

17. AO_value[@] = 31; //IR command Number:
18. AO_value[l] = 1; //IR Channel: 1

20. //connect to Modbus/TCP server
21. h = mtm_Register(Modbus_NetID,

22. TCP_IPADDR(Server_IP[@],

23. Server_IP[1],

24. Server_IP[2],

25. Server_IP[3]),
26. Modbus_Port);

27.

28. //wait TCP connection
29. while(hmi_TCPState(h) !=3)

30. {

31. hmi_DelayUS(100090) ; //delay 10 ms
32. }

33.

34. //send Modbus/TCP Request to IR-712(P)-MTCP

35. mtm_WriteAO(h,

36. Modbus_NetID,
37. Modbus_addr,

38. ch_count,

39. AO_value,

40. timeout);

41.

42. //disconnect TCP connection
43, mtm_Unregister(h);

44}
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E CAICPDAS\HMINVorks_Standard\Prajects\Test_forlR_CLang'__Frame1.h
File Edit Search Help

oK | Cancel ‘ ReFresh| Goto Lme|1

O

X

Widgets} Classes APIs ] 1 void BitButton4OnClick(tWidget *pliidget)
2
B-1. GEOMETRY 3{ //Handle for TCP connection
+ 2. FRAME 4 tHandle h ;
+-3. NETWORK CONFIGURATION 5
+ 4. TCP € //Modbus/TCP server information
% 5. MODBUS TCP MASTER 7 dnt Modbus NetID = 1;
< 6. MODBUS TCP SLAVE 8 ::mt Server_IP[4] = {192,168,255,1};
£ int Modbus_Port = 502;
+-7. MODBUS RTU MASTER )
+ 8. MODBUS RTU SLAVE 1 //Modbus Address
+-9. UART 12 int Modbus_addr = 1103;
+-108. DCON_IO 12 int ch_count = 2; //address 1163 &1 1184
# 11. WIDGET 1¢ WORD AQ_value[2];
+12. FLASH APT 1s DWORD timeout = 200; //280ms
16
= 13. 1QTT 17 AO_value[®] = 31; //IR command Number: 31
+ 14. DGW-521 18 AO_value[1] = 1; //IR Channel: 1
+ 15. MISCELLANEOUS 1s

20 //connect to Modbus/TCP server
21 h = mtm_Register(Modbus_NetID,
22z TCP_IPADDR(Server_IP[0],
23 Server
24
25

“1P[1],

Server_IP[2],
kberver IP[31),

26 Modbus_Port);

28 //wait TCP connection

23 while(hmi_TCPState(h) !=3)

30 {

31 hmi_DelayUs(1@0686); //delay 16 ms

32 }

33

] //send Modbus/TCP Request to IR-712(P)-MTCP

3as mtm_WriteAO(h,

£ Modbus_NetID,

27 Modbus_addr,

28 ch_count,

33 AQ_value,

a0 timeout);

41

a2 //disconnect TCP connection

43 mtm_Unregister(h);

a2 }

Copy the following C code to the OnClick event handler. It sends Modbus command to
IR-712(P)-MTCP with IR output channel 2 and write data to address 1103(IR command number)

and 1104(IR output channel) of holding registers.
46.void BitButton50nClick(tWidget *pWidget)
47.4

48. //Handle for TCP connection

49, tHandle h ;

50.

51. //Modbus/TCP server information

52. int Modbus_NetID = 1;

53. int Server_IP[4] = {192,168,255,1};
54. int Modbus_Port = 502;

55.

56. //Modbus Address

57. int Modbus_addr = 1103;

58. int ch_count = 2; //address 1103 & 1104
59. WORD AO_value[2];

60. DWORD timeout = 200; //200ms

61.

62. AO_value[@] = 31; //IR command Number:
63. AO_value[1l] = 2; //IR Channel: 2

64.

65. //connect to Modbus/TCP server

66. h = mtm_Register(Modbus_NetID,

67. TCP_IPADDR(Server_IP[0@],
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68. Server_IP[1],
69. Server_IP[2],
70. Server_IP[3]),
71. Modbus_Port);

72.

73. //wait TCP connection
74. while(hmi_TCPState(h) !=3)

75.  {

76. hmi_DelayUS(10000); //delay 1@ ms
77.  }

78.

79. //send Modbus/TCP Request to IR-712(P)-MTCP
80. mtm_WriteAO(h,

81. Modbus_NetID,
82. Modbus_addr,
83. ch_count,

84. AO_value,

85. timeout);

86.

87. //disconnect TCP connection
88. mtm_Unregister(h);
89.}

g CHCPDAS\HMIWorks_Standard'Projects\Test_forlR_CLang_Frame1.h
File Edit Search Help

OK | Cancel | Heﬂ‘esh‘ Goto L|ne|1

uidgetsl Classes APIs ] 46 void BitButton50nClick(tWidget *pWidget)
a7 {

+ 1. GEOMETRY 43 //Handle for TCP connection

+ 2. FRAME 43 tHandle h ;

+ 3. METWORK CONFIGURATION 50

+ 4. TCP 51 //Modbus/TCP server information

% 5. MODBUS TCP MASTER 2 dnt Modbus NetID = 1;

+ 6. MODBUS TCP SLAVE 53 int Server_IP[4] = {192,168,255,1};
54 int Modbus_Port = 582;

+ 7. MODBUS RTU MASTER =3

« 8. MODBUS RTU SLAVE s //Modbus Address

+ 9. UART 57 int Modbus_addr = 1163;

+ 18. DCON_IO 52 int ch_count = 2; //address 1183 &1 1184

+ 11. WIDGET s3 WORD AO0_value[2];
€0 DWORD timeout = 280; //280ms

+ 12. FLASH API
+ 13. MQTT

61

€2 AOQ_value[@] = 31;

# 14. DGW-521 €3 A0_value[1] = 2;

+ 15. MISCELLANEOUS €4
€5 /fconnect to Modbus/TCP server
&6 h = mtm_Register(Modbus_HNetID,
& TCP_IPADDR(Server_IP[0],
€8 Server_IP[1],
€3 Server_IP[2],
70 berver IP[31),
7 Modbus_Port);
72
72 J//wait TCP connection

74 while(hmi_TCPState(h) !=3)
75

7€ hmi_DelayUS(16608); //delay 10 ms
77 }
78
79 //send Modbus/TCP Request to IR-712(P)-MTCP
80 mtm_WriteAO(h,
L Modbus_NetID,
a2 Modbus_addr,
3% ch_count,
24 A0_value,
8s timeout);
86
a7 //disconnect TCP connection
a8 mtm_Unregister(h);
a9 }
<
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4. Finally, press F9 key to compile and download project to the TouchPAD.
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